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Microsoft PowerPoint Tutorial 

You will learn the following: 
 
Lesson 1.  Getting started, selecting slide templates, slide master 

 2.  Creating slides in slide view and outline view 
 3.  Creating graphics and graphs 
 4.  Inserting images, clipart and movies 
 5.  Builds, transitions and onscreen shows 

 
   Helpful hints for PowerPoint users 

Special notes 
If you do not have your own copy of PowerPoint: 
 
• The Department of Biochemistry currently has three general use Macintosh computers in 

room 302 of the Biochemistry Addition. They are available to all Biochemistry students 
via fob access. 

 
• DoIT maintains a list of computer labs on campus that are open to all students. You can 

view the list at http://www.doit.wisc.edu/computerlabs/labs.asp. 
 
• If you would like to purchase Microsoft PowerPoint, it is available at a substantial 

discount from DoIT ($81) as part of the Microsoft Office Suite, see 
http://wiscsoftware.wisc.edu/wisc/. 

 

Need more help? 
The Media Lab staff in rm 401 is there to help. They can teach you how to make, or consult and 
help you make, or completely create your PowerPoint talk for you. You can find out more 
information on the web at http://www.biochem.wisc.edu/medialab. The Media Lab’s web site 
contains many “How to’s” on popular problems you will run in to as you create your PowerPoint 
presentations, Posters and Research articles.  

Ready to give your talk? 
The Biochemistry auditoriums in rooms 175 & B1118, have built-in computers. These Macintosh 
computers have drives for floppies, CDs, zip discs, pen drives, and are also on the Department’s 
network. Feel free to bring your personal laptop in and connect it to the built-in projection system in 
either of these rooms. Remember, to be safe, test your talk IIN ADVANCE of your presentation 
date. The rooms are fob accessible. 
 
Whenever you intend to “show” your presentation on a computer other than the one it is developed 
on, it is a good idea to place a copy of the file, AND a copy of any included movies, into a special 
transfer folder, then use that folder to move the files to the second computer.  
• Place a folder called “Movies” in the same transfer folder as your presentation.  
• Place the movies you want to include into this “Movies” folder. 
• Use the Insert/Movies mode of PPT to place those movies into your presentation. 
• Now, when you move the transfer folder to any other computer, a copy of each required movie 

goes too, AND, they are in a folder (relative path) that your presentation can recognize and use. 
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Note: 
The images and screen dumps throughout this tutorial are from Microsoft Office X on a Macintosh. 
The specific screens you see on YOUR computer will depend upon the version of PPT you are 
running and the current preference settings… Don’t panic! The menus and options are pretty much 
similar for any PPT version on Mac and PC. 

For security reasons, the computers in rooms 175 and B1118 do not appear on the Macintosh 
Chooser Appletalk menu. Instead, there is a separate server called “Maitre d” in the Biochemistry 
AppleTalk zone. Log on as “guest” via the chooser (no username or password required), or as 
“maitred.biochem.wisc.edu” via ftp (username: transfer, password: bioshow). Place a copy of your 
transfer folder (label with your name, please!) into the “pub” subdirectory of this server. You can 
retrieve it onto the auditorium Mac before your presentation. OOR… go directly to one of the 
auditoriums and link to your computer from there and then transfer your files. 

 



Information Technology Media Center | Department of Biochemistry | UW–Madison | Tutorials 
155 

Key point: PPT can “work” with text in several different modes. If text is added into the title 
object box (“click to add title”), the program will forever recognize the particular information you 
placed on this slide as a “title object”, which means that it and all other similar title objects can be 
collectively and uniformly formatted by the Master Slide (see below). Likewise, any outline text 
added to the “body object” box (“click to add text”) can be collectively formatted for style, color, 
bullets, etc, on the master slide. 

Lesson 1. Getting started Master & Template 
 
1) Open PowerPoint. 
 
  Double click on the HHardDr ive  folder icon 
  Double click on the AApplica tions folder then the MMicrosof t  Off ice  X  folder 
  Double click on the MMicrosof t  PowerPoint  program 
 
2) Starting a new 

presentation. When you first 
open PPT, the program will 
show you the project gallery, 
choose PowerPoint and a blank 
presentation will open. 
 
3) Selecting a slide 

layout. The next window to 
pop up will ask you about the 
general layout of the slides that 
you wish to use in this 
presentation. Although there are 
many options here (title slides, 
slides with or without additional 
text, slides with graphs, slides with clipart, etc) don’t let this bother you! Any particular slide can be 
changed later, and you can insert images, graphs, or movies at any stage on any kind of slide. You 
can see all 24 possible layouts by scrolling within this dialogue box.  
 
Se lect  a generic slide layout with title and text called “BBulle ted Lis t”, as shown above. 
Click on the indicated slide template, then click OOK. The chosen slide (blank) will now fill your 
screen.  

 
 
Note: depending upon how PPT is configured 
when first installed, and the settings in the PPT 
customize folder (Tools/customize), the various 
toolbars and menus may look different from 
platform to platform. 
 
Don’t panic! All PPT functions are available 
somewhere in the menus and toolbars, you may 
just have to hunt a bit to find them.  
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Contextual Menus are little menus that pop up when you click the mouse to show you many 
useful shortcuts. The Menu changes to fit whatever you click on. 
 
Windows users: The “right-click” on a Windows computer is achieved by clicking and holding 
down the control key on a Macintosh. 
 
Macintosh users: Start using the second mouse button! Hold down the control key and click on 
something with the mouse. You will find many useful shortcuts! 
 

4) Use the Master Slide!!! You may set the background color, text size, font and style for each 
slide in your presentation by using the various menus at the top of the screen but it is much easier to 
pick a common format by specifying your preferences on the Master slide. This format will 
automatically be followed for all slides in your presentation, unless you turn it off for particular 
slides or chose to change any elements for a particular slide.  
  
Choose the “VView” menu, then “MMaster” then “SSlide 
Maste r” 
  
Choose the “FFormat” menu, and then explore the 
various options in the “MMaster  layout”, “SSlide color  
scheme”, “BBackground” and  “Apply design” menu. 
  
Insta l l any of these “looks” as your Master Slide, or 
chose your own fonts, colors, backgrounds and styles 
from among the many selections (e.g., Format menu, 
Fonts). 
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Note : within a body box, the <rtn> key takes you to the next line, and also creates the bullet for the 
next outline entry. If you ended up with an extra bullet, place the cursor after it, then press the 
delete key. 

Lesson 2. Creating slides SlideView & OutlineView 
 
The presentation you are going to create is one that you and your colleague, Christopher Columbus, 
will use to convince Queen Isabella to finance your new venture, called New World Expeditions. 
 
There are three views one can use to create PPT slides: Normal, Outline and Slide. In Slide View you 
see one slide at a time as you type the text and draw the graphics. In Outline view you see the outline 
of all the text on your slide. In Normal View, you see the outline, the slide and a place for speaker 
notes.  
 
1) Return to the first blank slide in your presentation (NOT the Master slide), by cc l icking on 
the Sl ide icon in the views button in the lower left corner of your screen (or select SSlides from the 
View menu) 
 

 
 
2) Type the title of the first slide into the title box 
 
Click in the title box, then type: WWe must ac t  soon 
 
Click inside the Body text box, then type the following short list, pressing return as indicated:  
 
 FFavorable  wea ther  <r tn> 
 Increase  in  competi t ion <r tn> 
 Avai lable  c rew  (don’t press <rtn>!) 
 

 
Click anywhere outside of the body or title boxes to deselect them. 
 
 
3) Save your work by choosing “SSave” from the File menu, and selecting an appropriate file 
name (e.g. PPrac t ice_1.ppt). 
 
4) Now we will make 2 more slides from the Normal View. This method is a really slick 
way to enter lots of nicely formatted text. You can easily use it to create a lot of slides for a lecture. 
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Note: when you press return in Outline View, PPT moves to the next line, and keeps you at the 
same level in the outline in which you were working (in this case, since you are at the title level, 
PPT presents the new slide icon, and is ready for you to type a new title). 

Note: Option + <rtn> is equivalent to the “Promote” button. If you had just hit return at this 
point, you could have added more bullets to slide 2, but now you are ready to begin slide 3, 
instead. 

Choose NNormal  from the VView menu, or click the NNormal icon in the lower left corner of the 
screen.  

 

 
 
Now click the NNew Slide  button, or select NNew Slide  from the IInser t  menu. This will create 
another “slide icon” in your outline and place the cursor next to it.  
 
Type the title of slide 2: EExpedit ion plan then press <<r tn> 
 

Click the “Demote” arrow (see image), to indent, or demote one level in the outline.  
 
Type the two bullet items: 
 PPrepare  a  f lee t  of  three  ships  <r tn> 
 HHand-se lect  a  sta f f  of  able  of f ice rs  and sai lors (press  Option + <<r tn>) 
 

 
Type in the following title for slide 3: BBenef i ts  to  Spain <r tn> 
 
Now press the  Tab key to indent one level and type the following the same way you typed the 
bulleted items above.  
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Note: The Tab key is the keyboard equivalent of the “demote” function 

 
 SSignif icant  r ise  in  t rade  <r tn> 
 MMore  revenue  for  the  c rown (don’t press <rtn>!) 
 

 
 
Your outline should look something like this. 
 
5) Go back to Slide view to see the new slides you have made. If you click on the thick double-
arrow icons at lower right of screen, you can shuffle back and forth among your slides.  
 
6) Reordering slides in SlideSorter view. 
 
Click on the SSlideSor te r  icon (lower left), or select SlideSorter from the View menu. 
 
Click on the picture of slide 3, hold down the mouse button and ddrag this sl ide to position 2 of 
your presentation. Note how the slide content remains exactly the same but the slide order is now 
different. 
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Note: the SlideSorter view is an excellent way to cut and paste slides from one presentation into 
another, or to reorder and/or delete slides from within a presentation. Just remember that each 
presentation will take its master format from its own master slide, and if you transfer in slides from 
another PPT file, they will assume the new master’s format in font, size, color and background. 
Therefore, it may be a good idea to pick a layout and master slide “look” that you like, and stick 
with it for many of your (and your lab-group’s) presentations. That way, you can mix and match 
slides from various presentations without messing up their carefully chosen color schemes! 
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Lesson 3. Creating   Graphics and Graphs 
 
PPT contains text and drawing tools so you can create your own graphics to illustrate your 
presentation. In these Lessons, we will draw some simple pictures, then create a graph for inclusion 
on a slide. In subsequent Lessons (D) we will expand these processes by importing pre-existing 
graphics that you might already have prepared in another graphics program, or perhaps downloaded 
from the web.  
 
1) Return to Slide view, then iinser t  a  new sl ide after slide 3. 
  
Click the NNew Slide  button at the top of the screen (or Insert menu New  Slide) 
Select a slide format “Title Only”, but with no other body or insert boxes (see next figure). 

 

 
 
2) Use the PPT drawing tools and drawing toolbars at the left or bottom of the screen to create 
some images that Christopher C. can use to help convince the Queen that his ships are seaworthy and 
can cross the ocean. These drawing tools are standard for most graphics programs. Explore a bit, and 
ask for help if you have NEVER done anything like this before. A sample slide is shown below.  
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Save  your  f i le  aga in, so this elegant piece of work is properly enshrined on the hard drive. 
 
Special note: it is a GOOD piece of advice to save your file frequently, especially when working 
on irreplaceable artwork. Some systems can crash, and many a potential Picasso has ended up in 
electronic vapor-land, when the file wasn’t properly saved! 
 
3) Now insert another slide (#5), in which we will create a graph to show the Queen how her 
costs vs profits may stack up during the next 4 quarters of the fiscal year.  
 
Se lect  “Text and Chart” from the new slide 
window. 

 
When the slide opens, cc l ick twice on tthe  
graph box, to initiate the 
spreadsheet/graphing power of PPT. 
 

 

 
 
 
Note: PPT contains several automatic graphing, clipart, and organizational chart functions that 
make it easy to create these types of aids in your presentation. The chart function essentially contains 
a small spreadsheet and the projected chart is drawn from the data in this sheet. If you wish, you may 
link the data to an external spreadsheet (preferably Microsoft Excel), or copy existing data into the 
PPT sheet. Either way, when you update the data in the spreadsheet, the displayed chart is 
automatically updated too. The chart menu bar which appears when you initiate a chart (Insert a new 
slide, with a chart function, or choose “Chart” from the Insert menu) allows you to choose the type 
of chart, color it, label the axis, title the graph, etc. 
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Change the default data in the chart spreadsheet to indicate how much profit in gold and silver the 
Queen might expect, vs her costs for this voyage. To do this, just select each spreadsheet cell in turn, 
and change its label or value. Note how the graph changes too, when you enter new values. 
(Example values, below left) 

 

 

 
 
When you are finished playing with the data and the chart, cchoose Quit (Command or  
Control  Q) , to return to SlideView.  
 
Now you can  add a  t it le  into the title box: 
 
 PProfi t  vs  Costs 
 
Also aadd some text  to  the  body box to explain your data: 
 

1st through 3rd Qtr costs may increase sl ightly until New Wor ld 
mines a re  opera t ional  <r tn> 
 
Therea f te r ,  the  looted gold and silver  should vastly exceed 
expedition costs . 

 
Note how the program automatically creates bullets to start each new body text object. If you wish 
to turn off the bullets, select the appropriate text with your mouse, then select the Bullet option in the 
Format Palette or Format menu. This is also how you can change the shape of the bullets, or their 
size and color. 
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Lesson 4. Inserting   Graphics, Clipart and Movies 
 
 
1) Inserting PPT clipart 
 
If you have not already done so, SSave  your file again. 
 
In Slide view, ssc rol l  back to the “My Ships” graphic slide you created earlier.  
 
In the  Inser t  menu, select PPicture  then CClipar t .  The Microsoft Clipart Gallery will open. 
You may wish to explore the various categories and clipart figures so you know what is 
available here. 
 
Select the category “wweather” then highlight “tthe  s torm” to add to your presentation. (This 
may help convince the Queen that your voyage will be exceedingly dangerous!).  
 

 
 
Your selected clipart will appear on the slide, and sometimes be too big or too small. 
 
To Resize click once on it to highlight it, then use the mouse to grab and move one of the corner 
boxes in or out. If you hold down the Shift key while doing this, the picture’s height and width 
proportions will remain unchanged..  
 
Alternatively, double-click the image and the FFormat Pic ture window will appear so you can scale 
your object by a defined percentage. Type 1120 in the dialogue box (120% of current size) then 
“OOK”. Your clipart will grow in proportion. DDr ag the storm with your mouse to a menacing 
position above your boats.  
 
Click once on the storm to select it. Then cc l ick and drag it with the mouse wwhile you hold 
down the option key, the storm will duplicate when you let go of the mouse. When using 
the ooption drag you must begin dragging the object before you hold down the option key 
AND you must let go of the mouse button first and then the option key. 
 
Add a bunch of rain clouds, draw some lightning, create a thunderstorm on your slide! 
 
Note: as with most computer programs, pictures, clipart or movies inserted into PPT can be resized 
by clicking on their corner boxes and dragging to an appropriate shape. However, this method can 
distort the figure’s proportions, display the pixels of the image or in the case of movies or .pict files, 
can also impair their ability to be displayed in OnScreenShows. We recommend that you only use the 
Object/Scale method of resizing for clipart, NNOT for images or movies. You may also use this 
feature to enlarge things by choosing a % that is >100 (e.g. 150%). 
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2) Inserting Movies 
 
Note: Ann Palmenberg has provided some sample QuickTime movies for use in your tutorial PPT 
presentation. Go to http://virology.wisc.edu/acp and click on Public Data, Class Resources to 
download a quicktime movie file. 
 
Note: If you highlight an inserted movie you can select Loop from the Movie tools in the 
formatting palette. This way your movie will play over and over during your onscreen show. 
 
Note: PPT will use the QuickTime movie player that is installed on your Macintosh or PC. It does 
NOT have its own internal movie player. Moreover, unlike images that can be inserted into your PPT 
presentation, when you tell PPT to insert a movie, the program only really inserts a pointer to the 
location of that movie on your harddrive. That is, PPT remembers where you told it to find that 
movie and goes back to that location whenever you want to play the movie. This is an IMPORTANT 
concept, because if you transfer your PPT presentation to another computer, you must also transfer 
the inserted movie files too, or the program can’t find them or play them. 
 
3) Inserting pictures  into PPT is similar to the insertion of clipart.  
 
Crea te a new sl ides at the end of your presentation that contains only a title box. (Just like 
Lesson 3.1 above). 
 
Open this new slide in Slide view, then select “PPic ture / From File” from the “IInser t” menu. In 
the dialogue box choose an image from your hard drive or download one from the web.  
 
Se lect a file then click OOK. The picture will appear in your slide, where it can be dragged to a 
favorable location. 

 
Note: You can insert many popular graphics formats into your PPT presentation: Joint 
Photographic Experts Group (JPEG), Macintosh Picture (PICT), Macintosh paint (PNTG), Portable 
Network Graphics (PNG), Windows Bitmap (BMP), Portable Document Format (PDF), Encapsulated 
postscript (EPS), Graphics Interchange Format (GIF), and Tagged Image File Format (TIFF). 
 
Note: Images should be inserted into PPT at the correct size. You should not have to scale them up 
or down in size. Scaling images up in size may show their pixels and scaling them down in size 
means the files are too large in size (bytes of information). There is a separate tutorial at 
http://www.biochem.wisc.edu/medialab under “How to” that goes over “getting images into PPT 
correctly”. 
 
Note: In the “Picture Palette” under “Tools” is a very useful element for working with pictures, 

called “Crop” ( ). Should you only require a small portion of a figure, the rest can be removed by 
judiciously cropping the edges of the inserted picture with this tool. You can also duplicate the 
picture and crop different portions from each image. 
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Lesson 5.   Builds, Transitions & OnScreen Shows 
 
1) Slide to slide transitions.  
 
Use Slide View to go back to the first slide of your presentation. Then click on the “OOnScreen” icon 
(the one that looks like a movie screen) in the lower left corner of your screen. The slide should 
FILL your Macintosh screen. 
 
Click <<r tn>, or click the mouse button, OR press the down-arrow key, to advance to the next slide. 
 
Note: There are 3 different ways to advance your slides sequentially during an “OnScreen” show: 
(1) by pressing the <rtn> key, (2) by pressing the “down-arrow” key, and (3) by clicking on your 
mouse. As you advance through your presentation, you can reverse the direction with the up-arrow 
key. Remember, some of these slides contain a lot of material, and each time you advance by any of 
the 3 modes, the computer must think a bit. Be patient. 
 
When you reach your movie slide, click twice on the movie to make it play. When you reach the end 
of your presentation, PPT will kick you out of OnScreenView and place you back into SlideView. 
You can end the OnScreen show at any time, by pressing the Escape (esc) key. Fun, isn’t it! 
 
If you wish, rrear range  the  order  of  your  s l ides  using the SortViewer .  
 
While you are in the SortView mode, you can easily add animated transitions for the slides, so they 
appear to morph into one another during your On Screen show. To do this, ccl ick on any slide, or 
group of slides to highlight it (them), then select a “SSlide tt ransi tion” from the SSlideShow menu. 
Select “BBoxIn” “Checkerboard” or whatever else seems interesting.  
 
Save your file, then run it through the  OnScreenShow again, to see what effects the various 
transitions have.  
 
 If you like, you may select a different transition between every slide... but if you actually do this for 
a REAL presentation, your audience will probably find it distracting to the information flow. 
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2) Building “body object” text.  
 
The entry of text into the “body-object” boxes that we practiced in Lesson 3, has two practical 
purposes. First, body-object text can be very easily entered in OutlineView, so it is directly formatted 
on new slides with almost no hassle. The second purpose for body text, is so text itself can be “built” 
or appear to be phased in, line by line, or point by point, during an OnScreenShow.  
 
Return to SSlideView, and select any of the 1st three slides we made (the slide should include a title 
and also several lines of body-text). Click on the body text to highlight it.  
 
In the SSlideShow menu, select AAnimation then WWipe Right or any other effect, then return to 
SlideView. 

 
Now rerun your OOnScreenShow and watch what happens when you hit this slide. Each click of the 
mouse should have an effect.  
 
Note: When the text of a slide is “built” the first click of the mouse will launch the slide. The title 
and any graphics will appear according to the “transition” mode that is selected. The next click of the 
mouse will launch the first key point of the body text, and each subsequent click will launch the 
subsequent points, so they appear on the screen one at a time, even though in reality they are all part 
of the same slide. 
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3) Building graphics, movies and other objects. 
 
PowerPoint will also allow you to “animate” virtually any text, pictures, graphics, charts or movies 
on your slides and play them with desired effects during your presentations. If you have several 
objects you want to link as a unit, be sure to “group” them before doing the following Lesson. 
 
Go to any of your slides that contains a few items of text, and perhaps some graphics, like your boat 
slide. 
Open the SSlideShow Custom animation menu.  

 
 

 
Choose an item on this slide (Group 3) that you wish to animate and then choose an EEntry E f fec t: 
for that item.  
 
If you choose to animate more than one object make sure you sse lec t the order  for each 
animation in the OOrder  and Timing Tab. Decide whether you want that event to happen at a 
specified timed interval, or at the next sequential mouse click. 
 
Remember also that you can ttest  the  e f fec ts  you have  c rea ted,  by clicking on the PPlay button.  
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Helpful hints for PowerPoint users 
 
1. Another way to “build” graphics is make successive slides, each with another part of the figure. 

Actually, it is easier to make the last slide (or the most complex slide) first, copy it successively in 
the Slide Sorter, then “erase” stuff from the initial slides so that it seems as if you are gradually 
adding more figures or text.   

2. Slide titles should never be less than 32 pt, for visibility. Text should never be less than 20 pt, 
and preferably larger.  

3. Remember the “Rule of 5 & 5”. In general, no more than five lines of text on a slide and no 
more than five words in each line of text on the slide! Think about it… if you use five lines of 
text and five words in each line that is 25 words for an audience to read and comprehend when 
they should be paying attention to you! 

4. Although PPT will allow the use of millions of colors, in truth there are few colors that make 
effective slides. Dark backgrounds (blue or black) are OK if the projection room is dark. In this 
case, yellow, white or light blue text will show up better. Other darker colors like green, orange, 
red may detract from your talk. Be careful if you use red text on a dark background. It may look 
fine on your computer but will project with poor contrast on the screen. Light backgrounds 
(white, grey) with dark text (black, dark blue, dark green), will always project nicely. Hint: the 
PPT default color schemes in FFormat/  Color  Schemes are effective, attractive and easy to use. 

5. If your movies don’t play right. Delete them then reinsert them. Sometimes, the PPT path 
pointers get screwed up. 

6. OnScreenShows require an LCD projector that can hook up to your computer. Properly 
installed, whatever you then see on your computer screen will be projected for the audience. 
Several campus halls, including Biochem 175 and B1118 are equipped for this. If you are 
planning to do a presentation elsewhere though, make sure you check out the equipment ahead 
of time in the Media Lab (rm 401 Biochem 98 Addition)  

      http://www.biochem.wisc.edu/medialab. 
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